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Chapter 1:

Introduction

The Video Turnstile system counts people entering and leaving premises

such as retail outlets, banks, galleries and museums. It is designed to be

easily installed and in most cases will require minimal set-up procedures.

The system comprises one or more black and white CCTV cameras each

associated with a Video Turnstile (VT) detection unit. When monitoring

several entrances, or wide doorways, we provide leads to connect the VT

units together. A lead is also provided to connect the video output from

the VT unit to a television monitor.

The detection unit produces a switch closure

signal (a pulse) each time a person crosses the

detection zone within the video picture. There

are two pulse trains, one for people going up

the video picture, and one for people going

down the video picture. With a Logging Video

Turnstile (LVT) unit, pulses from itself and up

to three other VT units can be logged and later

transferred to a PC via a serial link. A cable for

connecting the PC to the LVT unit is supplied.

There are switches on the back of each VT unit that can be used to fine

tune the detection to the installation. In most circumstances the default

settings should be adequate. However, if the system is missing counts or

counting people twice, then change the switch settings (Section 2.2).

This Manuals tells you how to:

• Install the Video Turnstile units and cameras (Chapter 2).

• Use Windmill software to configure the system and collect data

(Chapter 3).

• Deal with any installation problems (Chapter 4).
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Chapter 2:

Installing Video Turnstile

When installing Video Turnstile units it helps to have a television moni-

tor available. This lets you check that the picture produced by the camera

corresponds to the installation suggestions provided in this chapter.

2.1 Camera Positioning
We normally supply cameras with a 3.6 mm focal length lens. This is

suitable when the distance between the floor and the camera is two to

three metres. However, we can supply other lenses for greater

floor-to-camera distances.
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Mount the camera looking directly down.

2.1.1 Positioning Cameras Next to Single

Doors

For an entrance the width of a single door, consider these factors when

siting the camera.

1. Does the door open into the zone used by the Video Turnstile

detector? If so it is important that the door does not completely cross
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the detection zone. You therefore need to mount the camera some

distance inside from the door frame. This distance is typically 0.5 to

1 metre.

2. Where do people go after coming through the

door? It is important that people cross from

one zone line to the other in order to be

counted. People who turn left or right

immediately on coming through the door, and

who do not cross the second zone line, may

not be counted. Similarly people who enter

the detection zone from the side then go out

of the door may be missed. (Note: you can

count people entering or leaving through the

side by altering the unit’s switch settings, see

Section 2.2 for details.)

3. The detection zone should be reasonably well illuminated (so that a

good video picture can be provided by the camera). You should also

consider the lighting changes when:

i. The door opens. This may mean additional illumination from

outside areas, or changes in reflected light according to door

position.

ii. A person enters or leaves through the door. The person may block

out sources of normal illumination, or reflect additional light back

to the camera. A shadow may also be associated with the person

crossing the zone. The detection unit will normally cope with

changes to ambient light levels associated with people crossing

the zone. However shadows preceding, following or to the side of

people, may cause additional counts.
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2.1.2 Positioning Cameras Next to

Double Doors

For a double-width entrance mount the camera in the centre of the door-

way, some distance in from the line of the closed doors. Consider also the

previous guidance for a single door-width entrance.

2.1.3 Positioning Cameras in Corridors

For transit areas that are wider than a double-doorway, mount several

CCTV cameras in a line across the ceiling with the field of view of each

camera overlapping with its neighbours. Consider also the following

points.

1. The transit zone should be located where people are moving along the

corridor: a point where people stop to talk, look at exhibits,

advertising or route signposts, is not really appropriate.

2. Ideally, start by temporarily fixing the cameras: you will probably

need to move them after viewing the overlap of their detection zones.

3. The best position for the cameras is not necessarily evenly spaced

across the corridor. The cameras at the edge of the corridor may need

to be closer to the edges of the wall than equidistant spacing might

suggest.

4. People going through the overlapping zones between adjacent cameras

must be picked-up by both cameras, and be at the edge of each

camera’s detection zone. The VT detection units tell each other of the

presence of a person at the edge of the zone they are monitoring. This

means that the system handles a person being in the view of two

cameras at once, and can pick up people crossing the zone diagonally.

5. The cameras must be mounted in a line across the corridor spaced so
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that the detection zones overlap by about 10% at each end—see the

figure below and the Fine Tuning Camera Placement notes.

Fine Tuning Camera Placement in Corridors

To optimise the overlap between the zones from adjacent cameras, follow

these steps.

1. Disconnect the VT-VT loom (which connects the 25-way connectors

on the Video Turnstile detector units).

2. Connect the Video output from the leftmost VT unit to a TV, so that

you can see the camera image and the detection zone markers.

3. Mark the edges of the detection zone on the floor using something

easily removable like masking tape. A T-shaped piece of tape to show

the end and direction of the line is useful.

4. Connect the output of the adjacent camera and its VT unit to the TV.

5. Position the second camera so that its detection zone markers are on

top of those of the first camera with an overlap of roughly a third of a

metre.
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6. Repeat for the other cameras

7. Reconnect the VT-VT unit loom (which connects the 25-way

connectors on the Video Turnstile detector units), and check that

someone following the walking line is detected only once.
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2.2 Rear Panel Switches
On the rear panel of the VT unit are eight switches. These allow you to

optimise the VT for its location. You must always switch the VT off and

back on again after altering the switches since it only reads them at power

up. The switches are numbered 1 to 8, left to right. The numbers are visi-

ble through the panel. The default position of the switches is all UP. This

is a good starting position for a new installation.

The switch functions are as follows.

Switches 1 and 2: These control some of the VT settings that vary as the

camera is positioned at different distances above the floor. A person

viewed in a camera 2 metres above the floor will appear around 3 times

as large as when the camera is 3 metres above the floor, so these switches

will need adjusting to suit. The settings are :

SW1 SW2

UP UP Maximum Distance from the floor (over 3 m)

DOWN UP Next Setting

UP DOWN Next Setting

DOWN DOWN Minimum Distance from the floor (around 2 m)

If you find that people are being missed then move the setting to a greater

distance which in effect increases the sensitivity. Double counts would

indicate a move to a nearer setting.

Switches 3 and 4: There are many situations where people coming

through a doorway have a tendency to turn sharply left or right in order to

reach some particular attraction. To cater for this the VT can either count

only people who cross both upper and lower counting lines, or it can

count people who cross the lower counting line but enter or leave by the

edges of the counting area. To use this facility the camera must be

mounted so that the lower ‘must cross’ line is in the correct position. The

switches then allow entry and exit by left and right edges.

SW3 SW4

UP UP Straight Through only

DOWN UP Straight Through + Left Edge

UP DOWN Straight Through + Right Edge

DOWN DOWN Straight Through + Both Edges

Switch 5: This controls the ease with which one person following an-

other can be detected . In a very crowded situation where people are

packed closely together then this must be easily done. In a less crowded

situation then a more conservative option would be better since it pre-

vents false detections of shopping trolleys and the like.
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SW5

UP Makes Following difficult

DOWN Makes Following easy

SW6,7 Not Used

Switch 8: This sets the detector for the picture format from the camera.

Two frame rates are used for different camera types: 60 frames per

second for NTSC (or EIA for monochrome), and 50 frames per second

for PAL (or CCIR for monochrome). The switch adjusts the parameters

in the detector to cope with the different frame rates.

SW8

UP PAL - 50 fps

DOWN NTSC - 60 fps

Remember to switch the Video Turnstile unit off and on again for the

switch settings to take effect.
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2.3 Connections

2.3.1 Camera Din Plug

Pin Purpose

1 Video

2 0V

3 0V

4 +12V

2.3.2 240 DIN Connector Pin Out

Pin Purpose

1 VIDEO IN

2 0V

3 0V

4 12V

5 NC

2.3.3 9 Way D Plug Pin Out

RS232 RS485

1 Transmit-

2 Receive Data Receive+

3 Transmit Data Receive-

4

5 0V 0V

6 Transmit+

7

8

9 +12V +12V
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2.3.4 LVT to Microlink 800 Adaptor

When you are using RS485 connections, use the Microlink 800 to

connect to the computer’s COM (RS232) port.

LVT ML800 Adaptor

9-Pin Plug

6 1

1 2

2 3

3 4

5 5

(Note, when the flat side of the adaptor is on top, and the “curly” side un-

derneath, pin 0 is to the left and pin 7 to the right. See the photo below.)

Powering the Microlink 800 Adaptor

You would usually use the 12 V DC plug-top adaptor supplied to power

the Microlink 800.

In some situations, if you have a local LVT module, you can use power

from its power supply as follows.

LVT ML800 Adaptor

9-Pin Plug

5 (0 V) 6

9 (+12 V) 7

Note: Only connect 12 V DC wires from one LVT module. All other

sections of the RS485 should have 5 wire connections.
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2.3.5 25 Way D Socket Pin Out

Pin Purpose

1 0V

2

3

4 INPUT 6 Logger Input from other VTs

5 INPUT 4 Logger Input from other VTs

6 INPUT 2 Logger Input from other VTs

7 OUTPUT 0 DOWN Count Output

8 LINE SHOW Connect to 0V to disable

the limit lines

9 DISPLAY CLOCK Manufacturer use only

10 DISPLAY STROBE Manufacturer use only

11

12 RIGHT DIR Used in Camera Arrays

13 LEFT DIR Used in Camera Arrays

14 12V

15

16 INPUT 7 Logger Input from other VTs

17 INPUT 5 Logger Input from other VTs

18 INPUT 3 Logger Input from other VTs

19 OUTPUT 1 UP Count Output

20 0V

21 0V

22 DISPLAY DIN Manufacturer use only

23 0V

24 RIGHT CLAIM Used in Camera Arrays

25 LEFT CLAIM Used in Camera Arrays

2.3.6 Connecting More Than One LVT

When you are connecting more than one LVT, use the ribbon cables and

adaptors provided.
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Chapter 3:

Using the Windmill

Software

3.1 Introduction
Use the Windmill software to communicate with the Video Turnstile

units. With Windmill you can:

• Set the interval over which the LVT unit is to log people counts—

number of people per hour or per half-hour for example;

• Tell the LVT unit the correct date and time;

• Regularly collect logged data from the LVT unit and save it in a

text file;

• See live people counts.

Windmill comprises a suite of programs, each program performing a spe-

cific task. The main program you will use is VTupload. Once set up this

automatically collects the people counts from all the LVT units and saves

them in a text file. You can then open this file in almost any report

generator or analysis software.

VTupload subtracts the previous count from the current count, so if

running hourly would show just the counts for that hour. You can choose

how often VTupload is to run.

Other Windmill programs are included in your package, such as Logger,

Chart and DDE Panel. For details of these see Section 3.15.
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3.1.1 Using Windmill for the First Time

1. Install the software (see Section 3.2 for details).

2. Run Windmill VTupload (Sections 3.3—3.14) to: confirm

communications with the VT units, automatically collect people

counts and perform calculations on the data.

3. If desired run Windmill Logger, Windmill Chart or Windmill DDE

Panel (Section 3.15).

In subsequent sessions, unless you specify otherwise, everything will be

done automatically.
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3.2 Installing the Windmill

Software
To install Windmill use the CD labelled:

Windmill 6.0

For Video Turnstile

Insert the CD-ROM into the CD drive. Windows should automatically

start the installation program. If it doesn’t, then run the setup.exe program

on the CD.

The software is normally installed into the:

c:\program files\windmill software\windmill for

videoturnstile\

folder (where c: is the drive on which Windows is running.). Two other

folders are created, c:\videotunstile\setups\ that will hold

details of the program settings and c:\videoturnstile\data\

that will hold your data files.

At the end of installation the Configuration program—ConfIML—is run

to begin the setup process for your system. After using ConfIML run

VTupload to confirm communications and set up regular data collection

from the Video Turnstile Loggers.

3.2.1 Using Windmill ConfIML

You need to run ConfIML to register your Windmill system correctly.

Simply open the program then click the Save button. You should not

need to use this program again.
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Now start the Windmill VTupload program(Section 3.4) and confirm that

you can communicate with the Video Turnstile devices you have just

defined.

3.2.2 Installing over a Network

From the CD install the Lantronix Xport Installer and the

Devicecomm.exe program.

Setting the Address for the eLVT

1. Arm yourself with the necessary information from your network

manager, namely

• IP address for the eLVT

• Subnet mask

• If appropriate, Gateway address

2. Connect your eLVT device to a network enabled PC. You can use a

crossover cable to make a direct connection, or connect through a hub

via normal UTP Ethernet cables.

3. Run Xport Installer and click the Search button. The Installer should

find the eLVT as its default address: 169.254.117.220. You can

change the IP address of the eLVT by selecting an existing IP address

and then clicking the Assign IP button. After setting a new IP address

into the device, it will need to reboot. This takes around 10 seconds.

4. Click the Update button to set other parametres.

3.2.3 Assigning a Virtual COM Port

The eLVT appears as a serial device on your network. You can access

this with the VTupload program by specifying the COM port to which the

eLVT is attached. In Windows, go to Control Panel and select the

DeviceComm manager. This shows you a list of COM ports, and which

have been allocated. Select an unused COM port, and click Edit to enter

the IP details for the eLVT.

Video Turnstile User Manual 3.4
Biodata Limited, 10 Stocks Street, Manchester M8 8QG, UK
sales@videoturnstile.com | http://www.videoturnstile.com/

Chapter 3: Using the Windmill Software

http://www.videoturnstile.com/


3.3 Using VTupload
VTupload is the main program of the Video Turnstile system. It lets you:

• Tell the LVT unit the correct date and time;

• See live people counts;

• Set the interval over which the LVT unit is to log people counts—

number of people per hour or per half-hour for example;

• Give sensible names to each counter, such as PeopleIn;

• Transfer data from the VT loggers to the PC and save in a text file.

3.4 Starting VTupload
1. Make sure your Video Turnstile units are connected and switched on.

2. From the Windows Start menu, choose the Windmill 6.0 program

group then select VTupload.

The first time you use VTupload it starts like this.

VTupload knows that this is the first time you have run the program and

asks you for the details it needs. Click OK and it will present you with the

Site Details dialogue.

The first thing to do is to create at least one site from which to download

data. A site may be a collection of Video Turnstile units, or may be just

one unit. For instance, you could specify a site to be all units connected to

one COM port, or all units dialled from one telephone number. The pro-

gram starts by assuming you have a single site, with one Logging Video

Turnstile unit and up to 3 non-logging units, connected to port COM1 of

the computer.
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Site Name

Enter a meaningful name such as "Oxford Branch" or "Bakery

Line 4". This tells the user exactly which circuit they are dealing with,

so be sure to enter a clear definition.

File Prefix

This is an alphanumeric identifier which ties together several sites: the

data for all sites with an identical File Prefix will be collected together

as a single overall site. For example, a school may have three sites

with the names Classrooms, Kitchen and Boiler House. At these three

locations, there are loggers gathering data. The file prefixes are

defined identically as S1. This means that all logged data will be sent

to the same file, under directory name S1.

Installation Date

Defaults to today’s date. This defines the date from which VTupload

will scan for accrued data.

Connections to Logger Units

COM port number: You must specify the correct COM port i.e. the

one to which the LVT is connected. If the loggers are on an Ethernet

connection, create the virtual port using the virtual port software

provided (Section 3.2.3) and use this COM port number. If you are
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using a modem, choose the number of the COM port to which the

modem is attached.

Baud Rate: Leave the baud rate at 9600.

Modem Telephone Number: When using a modem to transfer data,

enter the modem’s dial-up number here. Include only figures: not

spaces, modem pause commas, etc. Remember to allow for additional

dialling numbers, such as those required for external lines.

Press OK and VTupload creates the site, storing the details in a text file

called sites.ini. The Prepare Windmill System window appears—see

below for details.

To change the settings you entered, or delete the site entirely, select the

Sites menu and choose Edit Site List. When you do this you must again

prepare the Windmill system. Select the Sites menu and choose Prepare

Windmill System. See the next section for more details.

3.5 Checking Communications

and Configuring the System
When you add a new site (or select the Sites menu and choose Prepare

Windmill System) VTupload gets ready to check your settings.

It asks whether you want to try to contact each Logger to confirm its

communications integrity. To do so click the Continue button. The pro-

gram checks the COM port that you specified in the Site Details dialogue

(page 3.6) and looks for all the LVT units attached to that port. On

completion the Edit Channel Details box appears for you to name your

counters (Section 3.5.1).
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If your loggers are not yet ready and you don’t want to contat them, select

instead Cancel. You can then enter the number of loggers at the site.

If you neither want to detect or enter loggers, you can proceed to giving

names to the counters. Press the Skip to Channel Edit button.

If you cannot establish communications, check the:

• wiring at the RS485 adaptor (if using);

• specified COM port;

• baud rate;

• Ethernet communications (Section 4.4).

Notes: When the system is configured what actually happens is an

iml.ini file is prepared and stored in

���������� 	
��
��
���
�� 
�	�������
���
���

The system also creates a file called vttowm.ims If you wish to

review the system configuration you can do so with ConfIML.

3.5.1 Giving Each People Counter a

Name

After preparing the system (Section 3.5) you are given the opportunity to

name your people counters.

Video Turnstile User Manual 3.8
Biodata Limited, 10 Stocks Street, Manchester M8 8QG, UK
sales@videoturnstile.com | http://www.videoturnstile.com/

Chapter 3: Using the Windmill Software

http://www.videoturnstile.com/


The counters are also known as channels. The ones on the first LVT unit

in your site are shown. These are initially called “00000”, ”00001”,

”00002”, etc. To rename them to something more easily understood sim-

ply type a name into the Name box, for example: IN_DOOR1 or

RH_OUT. Make sure the Enabled box is checked for each counter you

plan to use. When you make a change, buttons to Accept Changes or

Ignore Changes appear. Where a site comprises two or more LVTs, press

Accept Changes before moving on to the next LVT in the drop-down list.

If you have several sites, choose the one on which you want to work from

the Site list.

Press OK to permanently save the changes in a file called ����������.

You are now ready to make sure the VT loggers’ clocks match your

computer’s clock, and set the epoch length for each logger—as detailed

in the Secton 3.6. An epoch is the duration over which a set of counts is

stored, an hour or a day for example. The unit can store 256 epochs of

data from each counter. If your epoch is a day, therefore, 256 days of data

would be stored before the first was overwritten. If your epoch was an

hour, only 10 full days of data would be held at any one time.

Video Turnstile User Manual 3.9
Biodata Limited, 10 Stocks Street, Manchester M8 8QG, UK
sales@videoturnstile.com | http://www.videoturnstile.com/

Chapter 3: Using the Windmill Software

http://www.videoturnstile.com/


3.6 Configuring the Video

Turnstile Logging Units
From the Tools menu select Run SetupLVT.

Here you can adjust the LVT units’ clocks to match the computer clock

and change the epoch length. (The count is logged in memory at the end

of each epoch.)

1. Select which site’s modules (LVT units) you want to configure from

the Site Name drop-down list. The list has an extra item: Direct to

COM... If you select this you are asked for the COM port number and

baud rate. Details for any LVT modules in that site, or connected to

that COM port, will be made available.

2. Choose a Video Turnstile Logging unit from the Module drop-down

list and press the Change button. The settings for that unit are shown.
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3.6.1 Updating the Video Turnstile Unit’s

Clock

The clock will probably be wrong. To adjust it click the Reset button.

The time and date are updated to match those of the computer.

Note: The clocks in the LVT units are updated each time you download

data.

3.6.2 Changing the Length of the

Logging Epoch

The count is logged in memory at the end of each epoch. Type an epoch

length into the Epoch box (in minutes) and press the Change button.

When you change the epoch you should also update the clock by pressing

the Reset button. This ensures that the number of seconds to the end of

the epoch is calculated correctly.

The VT unit can store 256 epochs of data from each counter. If your

epoch is a day, 256 days of data would be stored before the first was

overwritten. If your epoch was an hour, only 10 full days of data would

be held at any one time.

The numbering system starts at 0, so the Current Epoch shown in the

setupLVT window will be between 0 and 255 inclusive.

3.6.3 Viewing the Updating People

Counts

The setupLVT window shows the updating people counts for your

selected VT Logger and its associated non-logging units. This is useful

during set-up to confirm that each counter is doing its job and counting

correctly. For example, Counter Channel 00000 may be counting people

going in through doorway one and Counter Channel 00001 may be count-

ing people going out of doorway one. You can send someone through the

doorway and see the count update on-screen.

Note: You can also use the Windmill DDE Panel to do this (Section 3.15.3).

3.6.4 Collecting Raw Count Data

You can collect the raw counts from all the VT Loggers attached to the

selected site. The counts from the 256 epochs will be stored in an ASCII

text file. (You wouldn’t normally use this method to download data, but it

is sometimes useful when setting-up the system. For details of normally

scheduling data collection see Section 3.8.)
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Press the Upload to File button.

The data file is stored in a setupLVT sub-folder and given the name

LVT_xx.wl, where xx is the number of the LVT unit. The name is

shown in the File Name box. This is for information only: you can’t edit

the name there.

The raw data thus saved are accumulating counts—the Video Turnstile

counters are not reset to 0 at the end of each epoch. This allows the two

logging processes—one local at the VT Logger and one at Windmill

software to computer disk—to proceed without interfering with each

other. This means that if 10 people entered during the first epoch, and 6

during the second, epoch 0’s count would be 10 and epoch 1’s 16.

3.6.5 Closing the setupLVT Window

To close the window select the Close button. The length of the epoch is

saved in a file called sites.ini, by default in the

c:\videoturnstile\setups\ folder.
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3.7 Performing Calculations
You can instruct VTupload to perform calculations on the count data and

store the results in the logged data file. You can thus group data from

individual VT counters. For example, if you have several cameras moni-

toring the width of a corridor, you can add together the up-corridor

counters for the total people entering, and the down-corridor counters for

total people leaving. You could also combine the people going in through

several entrances to get the total visitors to a store.

When you haven’t defined any calculations, VTupload’s stored data file

might look like this.
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The data from each counter channel is stored in its own column.

VTupload sees your calculations as more channels of data. If calculating

total visitors from several entrances, for example, you might create a cal-

culated channel called All_In which added together totals from IN_1 and

IN_2. Daily and weekly totals for this channel will be calculated.

Note: to perform calculations make sure the “Additional Reports” box is

checked in the Edit Setup Options screen, Section 3.11.

3.7.1 Defining Calculations

In the main VTupload window select the Sites menu and choose Edit

Calculated Channels.
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1. Press the Add New button. The Channel Details area appears.

2. Type a name for the channel into the Channel Name box.

3. Construct a formula for calculating the new value. Double-click a

count channel to add it to the formula.

4. Press Accept to save the new calculated channel.

5. Repeat for as many calculated channels as you need, then press OK.

Typically in Video Turnstile applications the formula will be a simple

sum of count channels, as in the example above. For the formula to work

count inputs need to be enclosed in square brackets. This is done auto-

matically if you double click a channel in the list.

More complicated formulae can be constructed if required. The Operators

/ * – +

are supported.
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The formula shown above involves two channels called D1_OUT and

D2_OUT. The order of operations is: / * – +, so the above formula is

evaluated as:

(50*([D1_OUT]/10))+(2.5*(([D2_OUT]/1.25)-[D2_OUT]))+6

Deleting Calculated Channels

To delete a calculated channel, select it from the Defined Channels list

and press the Delete button. If you are part way through creating a new

channel, and have not yet pressed the Accept button, you can just press

the Cancel button. The Clear button removes the formula, leaving you

with a blank box, but does not remove the channel.

Saving Calculated Channels

When you have created as many calculated channels as you need, press

OK. VTupload updates the calculated channels file. If no file yet exists it

will ask you to give the new file a name.

Turning Off Calculations

If you wish to temporarily turn off calculations, but don’t wish to delete

all the ones you have entered, you can do so. Select the Tools menu and

choose Edit Setup Options. When the Additional Reports box is ticked,

daily and weekly totals are created according to your calculated channel

definitions. When the box is not ticked, your calculated channel settings

are ignored. For more details see Section 3.11.

The Results of the Calculation

When a complete set of data for a particular day has been read from the

VT loggers, the calculated channels file is processed and the calculation

results appended to the file. Weekly files containing the daily totals are

also prepared.

Depending on your default folder (Section 3.9), the final directory

structure will be something like this:

c:\videoturnstile\data\site code\mmyy\

c:\videoturnstile\data\site code\weeks\

The mmyy directory is named according to the month and year, for exam-

ple 1103 for November 2003. It holds the raw data files in the format
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[SITE CODE]_DAYddmmyy.txt

Where [SITE CODE] is the file prefix you entered (page 3.6).

The weeks directory holds the weekly totals data files for this site in the

format

[SITE CODE]_WKyyyy_ww.txt

Where:

yyyy is the year,

_ww is the number of that week (between 01 and 53)
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3.8 Scheduling Data Collection
You can either continually run VTupload and schedule various times of

day when it will collect data, or you can set VTupload to run and collect

data once a day. The program subtracts the previous count from the cur-

rent count, so if running daily would show just the counts for that day.

Note: If you plan to use the other Windmill programs like Logger and

Chart, you must run VTupload continuously. You also need to select

the“Source of Data for Windmill” box in the Edit Setup Options screen

(Section 3.13).

3.8.1 Continually Running VTupload and

Collecting Data Several Times a

Day

From the Schedule menu select Upload times. This lets you set the times

of day when VTupload will collect data from all the Video Turnstile log-

gers. This assumes that the program is running continuously and be

available to perform data collection.

You also need to select the Tools menu, choose Edit Setup Options, and

tick “Source of Data for Windmill”.

Consider these factors when deciding how often to collect data.

• Epoch length: With 30-minute epochs (Section 3.6.2), 5 days of

data would be stored before the first was overwritten. If collecting

data daily then this means that if there are problems with the

computer then 4 consecutive communications failures can be

tolerated before data is over-written. If you are considering collect

data less frequently then this time factor should be borne in mind.

• Patterns of use of the host computer: If the host PC is being used

during working hours as a user’s main PC, the schedule for

download should be set to a time during lunch time or evening

when the PC is not in use. This is especially important when large

numbers of sites are used which will mean longer periods of

potentially slow PC performance.

• Telephone line use: If the telephone line being used for dialling to

a logger is less likely to be used for voice calls at a particular time,

favour the scheduling of downloads for this time.

• Network traffic: If TCP/IP network is being used, it is good

practice to favour times of low network traffic for data transfers.

• Likelihood of communications failures: If a telephone line being

used for data transfer is likely to be used for voice telephony at

times when downloads are initiated, the scheduled task repeat
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should be sympathetic to this and should repeat a dial-out more

frequently than would otherwise be necessary.

You are also able to collect data at unscheduled times. Click the Upload

Logged Data button from the VTupload main window (page 3.23).

3.8.2 Running VTupload Once a Day

(or less Frequently)

Use Windows Task Manager or Scheduled Tasks (depending on your

version of Windows) to schedule automatic data collection. For example,

in Windows 98 you will find Scheduled Tasks in:

Start > Programs > Accessories > System Tools > Scheduled Tasks.

Look for the VTupload program and click the Next button. Choose

whether to collect data daily, weekly or monthly. Select the time for

collection.

The command to initiate a download is the path of VTupload.exe. For

example:

“$�%&'
('�� 
����%�������� �
)�*�'�%��������%���	�
��+�,��

When deciding the time of day to start VTupload and download data,

consider the points detailed in Section 3.8.1.
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3.9 Changing Default Folders
When you use Windmill you will create two types of files, those which

hold data and those which hold the Windmill programs’ settings. You

choose which folders are to store these files. We recommend using

c:\videoturnstile\setups\ and

c:\videoturnstile\data\

where c:\ is the drive on which you installed Windmill.

If you do wish to change this select the Tools menu and choose Edit

Setup Options.

Erase the current file locations and enter two new folders (directories). If

you want to save each month’s data in its own sub-folder, make sure the

Data in Monthly Directories box is ticked. The sub-folders will be named

according to the month and year. For example:

c:\videoturnstile\data\0704 for July 2004

c:\videoturnstile\data\0804 for August 2004 etc.

This dialogue also lets you

• Compensate for under counting (Section 3.10)

• Turn off calculated channels (Section 3.11)

• Specify whether data should be made available to the other

Windmill programs (Section 3.13)

• Specify VTupload’s epochs per day (Section 3.12)

• Change the data format. However, you should leave this at 0 as this

indicates integer data.
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Note: What this dialogue is actually doing is editing the

vtupload.ini file. Notes on the ini file are in Section 3.9.1 below.

You can ignore this if you wish.

3.9.1 The vtupload.ini File

The starting data in this file is:

�	
�

���
� �������������������
�����������
��
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������������

���� ��������

��� �� ��
 ������ �������� ��� ��� ���� ����
�

��� �������� ���� �����

��� ��� ����� ����� ��� �� ��� 	
 ������ ���� ���������

��� ��� �������� ���� ���� � ������� ��� �� ����

�������� ��� ���� !

������

������� ��������������
�

�������������

��
����� ����� �������"��

�������� ���������

Notes on the ini File

• These setup and data directories are created when you install

VTupload. You can change them to more suitable directories.

• Data format=0 is for integer data (or 0.0 for one decimal place, but

this is not suitable for counting people)

• Readings per day is the number of time epochs in a 24 hour

period—so 24 for hourly, 48 for half hourly counts etc.

• Monthly Directories=true sets a flag so that subdirectories created

from the month and year (MMYY e.g. 0103) will be used to save

the data files. If the right hand side of the expression is not true

(e.g. false or 0) or the entry is not included then monthly

subdirectories will not be used.

• Calculated channels are enabled if reports=true. If a calculated

channel file exists then these definitions are used. Otherwise the

sum of odd channels and the sum of even channels and daily totals

are calculated. If reports=false then no calculations are performed.

• Windmill handler determines whether data will be made available

to the other Windmill programs (Logger, Chart, etc.). If windmill

handler=0 then no data is provided to them.

You can either edit the vtupload.ini file directly, in Notepad for example,

or use VTupload to do so (by selecting the Tools menu and choosing Edit

Setup Options). If editing directly please make a backup copy before

doing so.
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3.10 Compensating for

Under-Counting
Video Turnstile is a conservative system and tends to under-count rather

than over-count. When validating your system, you can increase the sen-

sitivity of the people detection using switches on the back of the Video

Turnstile logging units. See Section 2.2 for details.

If you have adjusted the switches and the count is still low, then you can

scale the count up. Select the Tools menu, choose Edit Setup Options and

enter an appropriate scale factor.

If the system consistently misses 5% of people for example, you can

compensate for this by entering a scale factor of 1.05 (to the nearest 2

decimal places).

3.11 Turning off Weekly and Daily

Total Calculations
If you have defined calculated channels, for example to combine the

counts from several doors, then daily and weekly totals will normally be

calculated. However, if you want to turn off the calculations you can do

so.

Select the Tools menu and choose Edit Setup Options. Remove the tick

from the Additional Reports box.

If you tick Additional Reports, but have not specified any calculated

channels (Section 3.7) then the sum of odd channels, the sum of even

channels and daily totals are calculated.

3.12 Setting VTupload’s Epochs

per Day
Counts are saved in epochs. If there are 24 epochs in a day then the total

counts each hour are logged. To change the number of epochs VTupload

logs in a day, select the Tools menu and choose Edit Setup Options.

The epoch times for each VT logging unit can be different (set with the

setupLVT window, Section 3.6.2). VTupload compares the actual epoch

time with its epoch per day setting. If the epoch time is shorter than the
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epochs per day setting—for example if the epoch time is 30 minutes but

there are 24 epochs per day in VTupload—then the epochs are added to-

gether. So two VT unit epochs will be combined into one VTupload

epoch. Similarly, if the VT unit’s epoch is 120 minutes and there are 24

epochs per day in VTupload, then every other one of the 24 epochs will

be 0.

3.13 Running the Other Windmill

Programs
If you wish to use the other Windmill data collection and display pro-

grams, such as Windmill Logger and Windmill Chart, you should instruct

VTupload to make the data available to Windmill. Select the Tools menu

and choose Edit Setup Options. Make sure the “Source of Data for

Windmill” box is checked (marked with a tick). VTupload needs to be

running for the other Windmill programs to collect the data.

If you are not planning to use the other Windmill programs, you can set

VTupload to run daily (for example), collect the data and update the daily

data files. See Section 3.8.2 for details.

The benefit of using the other Windmill programs is that you will be able

to

• see real-time data (the current counts at that moment);

• log accumulating counts at a rate you choose, every 5 minutes for

example, independent of the logging epoch in the Video Turnstile

units;

• chart the count;

• purchase additional programs to let you, for example, see a floor

plan with incrementing counts at each doorway.

For more on the Windmill programs see Section 3.15, their Help files or

http://www.windmill.co.uk/

3.14 Closing VTupload
To use the changed set-up, you need to:

1. Close VTupload: select the File menu and choose Exit.

2. Close any Imblkbrd device handlers that are on the Windows toolbar.

3. Re-open VTupload.
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When you re-open VTupload it looks like this.

If you want to change any settings you need to click the Abort Auto

Operations button. If you don’t do so within 10 seconds, then press the

Cancel Auto Transfer button that appears. The program will close and

you will have to restart. This happens because VTupload normally runs

once a day, collects data from the logging units, and then shuts down. It

waits 10 seconds before doing so though, to give you a chance to change

its settings.
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3.15 The Other Windmill Programs
As well as VTupload. several other Windmill programs are included in

your package.

• Windmill Logger displays people counts and stores them in a file

on the PC’s hard disk at regular intervals—every 5 minutes for

example. This rate is independent of the Video Turnstile unit’s

logging intervals. So you could, for instance, use the VT unit to log

counts every hour and Windmill to log counts every 5 minutes.

• Windmill Chart displays the accumulating people counts as a

graph.

• Windmill DDE Panel shows a live display of each count but

doesn’t save any data. You can use DDE Panel as a DDE server.

This means that other programs, such as spreadsheets like Excel,

can request and save live counts.

The IML Device Icon

Whenever you run a Windmill program one or more IML Device

icons appear. Different icons identify different hardware drivers. The

Windmill applications can’t run without these, so don’t close them

whilst using Windmill.

If Windmill Logger, Chart or DDE Panel fail to display any data, make

sure you have enabled their use in VTupload. Section 3.13 refers.

Notes on using the other Windmill programs are given below. For full

details see the programs’ Help.

3.15.1 Using Windmill Logger

Windmill Logger displays people counts and stores them in a file on the

PC’s hard disk at regular intervals—every minute for example.

1. Load the vttowm.ims file you created with VTupload.

2. Connect the count channels.

3. Type a name for the file you want to hold the people counts into the

Data File box, for example retail.wl. This file is in ASCII text and you

can open it using any word processor, spreadsheet or other Windows

analysis software.

4. Press Start to begin logging data.

Video Turnstile User Manual 3.24
Biodata Limited, 10 Stocks Street, Manchester M8 8QG, UK
sales@videoturnstile.com | http://www.videoturnstile.com/

Chapter 3: Using the Windmill Software

http://www.videoturnstile.com/


With Logger you can periodically create a new file—every day or every

week for example. For full details of this and other features select the

Logger’s Help menu.

You can use VTupload to zero Windmill Logger. For example, if you

zeroed Logger at the start of the day it would show just today’s count. To

do this, in the VTupload main window (page 3.23) click the Zero Counts

button.

You can log VTupload’s calculations with Windmill Logger (assuming

you have enabled this in VTupload—Section 3.13). Use Logger’s Inputs

menu to select the calculated channels.

To backup the data you are saving with Windmill Logger, you should

also schedule VTupload to regularly collect data (Section 3.8.1).

3.15.2 Using Windmill Chart

Chart shows a graph of occupancy (the difference between the IN and

OUT counts) against time. To use Chart follow steps 1 and 2 above as for

Logger then press Start. For full details of using Chart select its Help

menu.

3.15.3 Using Windmill DDE Panel

Use DDE Panel to check that the VT logging unit is collecting count data

from all its connected VT units. (A VT Logging unit stores counts from

itself and up to three other non-logging VT units.) DDE Panel shows a

live display of each count, so when a person goes through one of your
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entrances the program shows the updated total. DDE Panel, however,

doesn’t save any data.

DDE Panel’s display is regularly updated according to its Refresh Rate.

This can be from 0.5 seconds upwards. There is no point in setting the

update rate faster than the computer can acquire the data. This is espe-

cially relevant with serial links, which are relatively slow.

You can also use DDE Panel as a DDE server. This means that other

programs, like Excel, can request and save live counts.

It’s easy to use DDE Panel

1. Load the *.ims file you created VTupload. This is called

c:\videoturnstile\setups\vttowm.ims.

2. Connect the count channels.

That’s it. DDE Panel will show the incrementing counts from the Video

Turnstile units. For full details of using DDE Panel select its Help menu.

Video Turnstile User Manual 3.26
Biodata Limited, 10 Stocks Street, Manchester M8 8QG, UK
sales@videoturnstile.com | http://www.videoturnstile.com/

Chapter 3: Using the Windmill Software

http://www.videoturnstile.com/


Chapter 4:

Troubleshooting

Here are the solutions to five potential problems with the Video Turnstile

system.

1. No counts are recorded and the Up and Down lights on the VT

module flash regularly.

2. Counts are missed when two or more people go through together.

3. A VT module is missing.

4. You cannot get reliable communications with an LVT over Ethernet.

5. You have problems connecting the units over RS485.

4.1 No Counts are Recorded and

the Up and Down Lights

on the VT Unit Flash Regularly
This indicates that there is no video signal going into the Video Turnstile

unit. Although the lights flash briefly, the counts are not incremented.

You need to determine why there is no video signal.

1. Check the cable connections between the VT unit and the camera.

2. Check with a multi-meter that 12 V DC is available at the camera end

of the cable.

3. If you have more than one LVT or VT unit, swap the connection to

the VT with another camera that is working.
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4.2 Counts are Missed when Two

or More People go

through Together
By adjusting switches on the back of the VT unit you can increase or de-

crease the sensitivity of people detection. Switch number 5 controls how

the unit reacts to people following close behind each other against the

alternative of someone pushing a shopping trolley or baby walker.

If people side by side are being counted as one person, try changing

switches 1 and 2 which control the size of a typical person in the picture.

Between 2 and 3 metres above the floor, the area of screen taken up by a

1.8 m tall person changes considerably. A person viewed in a camera

2 metres above the floor will appear around 3 times as large as when the

camera is 3 metres above the floor.

For more on the switch settings see Section 2.2.

If you have adjusted the switch settings and you are still under-counting,

you can scale the count in software. See Section 3.10 for details.

4.3 A VT Module is Missing
If an LVT module, in a group of modules, suddenly disappears then the

address of that module has probably been changed. This may be due to an

electrical transient, in which case the address has probably been reset to

0. You may then have two modules with address 0.

Use VTupload to find which module has lost its address. You may need

to disconnect all the LVT modules and reconnect them one at a time to

identify the correct one. Having found it you can use VTupload to

re-enter the address of the module.
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4.4 You cannot get Reliable

Communications with an LVT

over Ethernet
Check with Hyperterminal that you can talk to the module (see

Section 4.4.1 for details). Follow the steps to Request the Hardware

Type. Did you get back the correct reply?

No: You need to check the setup of the Lantronix virtual COM

port and the Ethernet connection.

Use the Xport Installer program to check the setup.

1. Use the Search button to get a list of LVT units (and any other

Lantronix Xport devices) on your local network.

2. “Ping” the LVT unit to confirm that there is a network connection to

it: click the Ping button and enter the IP address of the LVT unit you

want to check.

The response time for communications with a locally connected LVT unit

will typically be 0 msecs.

Yes: Wait 10 seconds then repeat the steps to Request the

Hardware Type.

Did you still get back the correct reply? If not your LAN is probably rout-

ing your messages out to a WAN, as well as to the LVT. Check the

GATEWAY setting with your network manager.

4.4.1 Using Hyperterminal to talk to a

LVT module

Load the Windows Hyperterminal program

#��$������� �����$�����������$��������������$������������%

and set up the communications as follows:

Connect To tab

Connect using:

Direct to COMx

(where x is the port number to which your

LVT is connected.)

Configure ...:

Bits per second 9600

Data bits 8

Parity None

Stop Bits 1
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Flow Control None

Settings tab

Ascii Setup ...:

Ascii Sending

Echo characters typed locally - Checked

others as default

Ascii Receiving

Default settings

You should now be able to communicate with a module over the serial

link created. To request the hardware type you need to know the ad-

dress of the module with which you are trying to communicate. The

default address for a single LVT module is 0. (You can check and change

the module address using the VTupload program)

Using Hyperterminal to read the hardware type for a module with address

x you need to type:

*x DCO HT

(and press Enter)

the reply will be:

x: ML825

(possibly followed by another letter)

e.g. for address 0

you send *0 DCO HT

and get back 0: ML825

You will not get a reply if:

• There is no communications link between the PC and the LVT—

check the cable(s).

• You have sent the wrong address—check with VTupload.

• The LVT is not powered.
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4.5 Problems Connecting RS485

Units
Here are some tips on connecting LVT units using RS485 cables.

1. Try to arrange a local RS485 connection from your PC. Bring the

LVT modules one-by-one to this local connection.

2. Use SetupLVT (Section 3.6) to change the address of each LVT

module in turn. LVT modules are sent out with default address 0. If

you connect the LVT to your RS485 link, and power up the LVT,

SetupLVT should find it at address 0. You will need each LVT on an

RS485 connection to have a different address. Start from 1 and work

up. It is best to leave address 0 free so that you can add a new LVT to

your system and find it while all the others remain connected.

3. If you do not arrange a local connection, check each LVT in turn. That

is, go to the nearest LVT to the PC with only a single section of cable

between the PC and LVT, and disconnect the rest of the LVTs.

Check the continuity of the cable by twisting the Tx� and Tx�, and the

Rx� and Rx� wires at one end of the cable section and using a

multimeter to check continuity at the other.

You can then check continuity of a new length of RS485 cable and

attach it to the 5-way screw terminal block.

4. RS485 cable should be 2 twisted pairs + screen. Use:

1 pair for Tx pair

1 pair for Rx pair

and screen for signal ground.

Ethernet cable can also be used in non-hostile environments.
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